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A-1Safety Information

SAFETYA.
Read this manual carefully before using the Datalink 7 diagnostic 
software. Datalink 7 is intended for use by professional technicians 
who have a thorough understanding of the Proheat G-II PCM M-Series 
heaters. This understanding is essential for an accurate, reliable 
and safe use of Datalink 7.

It is the users responsibility to be knowledgeable of the heater 
being diagnosed. Always use the applicable service methods 
provided by Proheat to ensure there is no risk to personal safety, 
the safety of others, and to prevent damage to the heater being 
diagnosed.

Throughout this manual, you will see notes labeled DANGER, 
WARNING, CAUTION, and NOTICE to alert you to special instructions 
or precautions concerning a particular procedure that would be 
hazardous if performed incorrectly or carelessly.

Observe them carefully!

These safety alerts alone cannot eliminate all hazards. Strict 
compliance with these special instructions and common sense 
are major accident prevention measures.

Immediate hazards that will result 
in severe injury or death.

 DANGER

Hazards or unsafe practices that 
could result in severe personal 
injury or death.

 WARNING

Hazards or unsafe practices that 
could result in minor injury or 
product or property damage.

 CAUTION

Information that is important to 
proper installation or maintenance.

NOTICE



B-1PCM Identification

PROHEAT CONTROL 
MODULE (PCM) TYPE

B.

This manual covers only the G-II PCM.
Datalink 7 is for the G-II PCM only. G-I and G-II PCM's can be 
identified in the figure below.

G-I PCM G-II PCM

METRI-PACK 
12052644 AUX
CONNECTOR
KEYING

7 PIN 
DATA LINK
CONNECTOR

FOUR PIN
DUAL MODE
TEMPERATURE
SENSOR
CONNECTOR

METRI-PACK 
12052641 AUX
CONNECTOR
KEYING

2 X TWO PIN
ANALOG
TEMPERATURE
SENSOR
CONNECTORS

6 PIN 
DATA LINK
CONNECTOR

NO AIR FILTER 
RETENTION 
TANGS

AIR FILTER
RETENTION 
TANGS

STATUS
INDICATOR
LIGHT

Figure B-1. G-I PCM and G-II PCM.

Datalink 7 is for the G-II PCM only.

NOTICE
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1.0

1.1

Introduction
Datalink 7 for G-II PCM M-Series heaters is a diagnostic tool 
which consists of software and companion files that run under 
Windows 2000, XP, Vista or 7 and an interface cable that 
connects the USB port of your computer directly to the diagnostic 
port of an G-II PCM M-Series heater.

Datalink 7 will allow trained personnel to:
•	Read heater information
•	Monitor heater inputs and outputs
•	Monitor heater diagnostic trouble codes
•	Update heater firmware
•	Save heater information to a file

Interface cable
Datalink 7 for M-Series requires the use of the following USB 
interface cable:
•	Part Number: PK0064

Minimum Computer 
Requirements
The minimum computer requirements to run Datalink 7 are:
•	1 GHz Pentium III processor or higher
•	Microsoft Windows 2000, XP, Vista or 7
•	USB 1.1 or higher
•	15 MB of hard disk space

1.2

Figure 1-1. Interface Cable
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2.0

2.1

Installing Datalink 7
Datalink 7 is provided with a software installer to guide a user 
through the installation process. During setup, the installer 
automatically records events for uninstalling Datalink 7. Any files 
or folders that are created and logged during setup can be 
automatically removed using the standard Windows program 
remover. Files that are added to the installation folder after the 
setup was completed are not removed by the program remover.

Please uninstall any previous version of Datalink 7 using the 
add/remove programs option in windows. 

Launching the installer
Go to www.proheat.com and download the latest version of Datalink 7 
for G-II PCM M-Series heaters. Save it to your Desktop. Open the 
saved Zip file and extract the Zip file to you desktop.

If Datalink 7 is being installed on Windows Vista or 7, the installer 
must be run as an administrator. To do so, right click on the installer 
file and select Run as administrator from the popup menu (See 
Figure 2-1 below).

Do not connect the M-Series PCM 
interface cable to the USB port of 
a PC until the device drivers and 
Datalink 7 are completely installed 
and the computer has been restarted.

 WARNING

Figure 2-1. File popup menu.
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2.2.1

2.2.2

Setup dialogs
The Datalink 7 installer successively displays four setup dialogs. 
At any time during the setup process, click on the Cancel button 
to stop and quit the installer without installing Datalink 7.

Welcome dialog
The first dialog is a welcome message. As recommended by  the 
dialog, close all other applications before installing Datalink 7. 
Choose either the Next or the Cancel button.

Software license agreement dialog
Scroll down to read the software license agreement, you must 
accept the agreement to continue with the software installation 
by clicking "I accept the agreement" then choose "Next" to 
start the installation process.

2.2

Figure 2-2.Welcome dialog.

Figure 2-3. Software license agreement dialog.
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2.2.3

2.2.4

2.2.5

Installation progress dialog
While the installer copies the files, it displays the following 
Installation progress dialog. Choosing Cancel will stop installation.

USB driver installation
The following message informs the user that the USB driver 
required to communicate with the M-Series PCM will be installed. 
This operation may take several minutes. Click OK to continue 
the installation.

Setup complete dialog
The Setup Complete dialog is displayed when the installation 
has completed. Select the option to restart the computer and 
press the Finish button to close the installer. The computer can 
be restarted at a later time, but it must be restarted before 
Datalink 7 can be used.

Figure 2-4. Installation progress dialog.

Figure 2-5. USB driver installer dialog.
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Figure 2-6. Setup complete dialog.

If required please restart your computer.
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3.0
3.1

Using Datalink 7
Power and connections
Before attempting to connect to a G-II PCM with Datalink 7, always 
perform the following steps in order:

1.	Connect battery power to the G-II PCM first.

2.	Wait for 5 seconds. G-II Status light will flash Green twice.

3.	Connect the PCM side of the diagnostic cable to the 7-pin 
diagnostic port of the G-II PCM. 

4.	Connect the USB side of the diagnostic cable to a USB port of 
a computer with Datalink 7 installed. See picture below.

Note:
If the diagnostic cable is connected before battery power is applied 
to the G-II PCM, the G-II PCM will go into Lock out mode (the Status 
Light will be flashing alternating RED then GREEN). which prevents 
the heater from working. To unlock the G-II PCM, follow these 
steps:

1.	Disconnect the diagnostic cable from the computer.

2.	D isconnect battery power from PCM.

3.	 Wait for 20 seconds.

4.	 Reconnect battery power to PCM.

5.	 Wait for 5 seconds. G-II Status Light will flash Green twice.

6.	R econnect the diagnostic cable to the computer.

Figure 3-1. Interface cable connection.
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3.2 Starting Datalink 7
Datalink 7 is started by double-clicking on the desktop icon (shown 
left) or by selecting Datalink 7 from the: Windows | Start | Programs | 
Proheat menu.

Once it has completed its internal initialization, Datalink 7 will 
display the Workspace window.

Figure 3-2. 
Datalink 7 icon.

Figure 3-3. Datalink 7 Workspace window.
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Figure 3-5. Datalink 7 Workspace window with a PCM detected.

Figure 3-4. Datalink 7 Workspace window with a PCM detected.

3.3 PCM detection
Upon start-up, Datalink 7 automatically launches a background 
program that continuously monitors the USB ports for the presence 
of a Silicon Labs* USB interface. When a Silicon Labs USB 
interface is detected, it is listed under the Interfaces list of the 
Workspace window and an M-Series PCM node will be listed 
under the interface.

Beside the M-Series PCM node is a plus sign (+) which can be 
used to expand the node and display more information about the 
node (for example PCM part number, firmware revision etc).

* Manufacturer name of the USB interface chip used inside the PCM.
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3.3.1

3.4.1

Monitoring PCM presence
If communication between Datalink 7 and a G-II PCM is suddenly 
lost, then Datalink 7 draws red crosses over its interface and node 
icon. If Datalink 7 sees the G-II PCM again, the red crosses disappear.

Figure 3-6. Lost PCM.

Figure 3-7. Database search error message.

3.4 Opening & Reading a PCM
To open and read a G-II PCM, select it from the Workspace 
window and then press the tool bar Read button. You can also 
double-click on its name from the Workspace window.

G-II Database error message

If the Datalink 7 software is older than the G-II PCM Firmware or 
the Datalink 7 software cannot find a database file that matches 
the G-II PCM software part number and revision, then it displays 
an error message that will be similar to the one shown below.  
Visit www.proheat.com to download the latest version of Datalink 7. 
Then Read PCM again.
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3.4.2

Figure 3-8.

Figure 3-9.

Figure 3-10.

New Firmware

If the Firmware in the G-II PCM is older than the Datalink 7 software 
you will have the option to update it during the initial Reading of 
the PCM. You can choose not to update the PCM firmware by 
selecting “No”.

Selecting “Yes” will update the Firmware.

When the Firmware update is finished please follow the on 
screen instructions.
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After opening the G-II PCM, Datalink 7 starts reading the content 
of the G-II PCM memory while showing the following progress bar.

Figure 3-11. Reading progress bar.

3.5 G-II PCM window
After Datalink 7 has completed reading the content of a G-II PCM, 
it creates a new window and displays the G-II PCM information 
tab. A number of additional tabs are available each containing 
different pages for viewing G-II PCM data. 

Figure 3-12. PCM window.
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3.6 PCM pages
Each PCM window is divided into five pages. Each page can be 
opened by selecting its corresponding Tab. The table below 
summarizes the content of the different PCM window pages seen 
when Datalink 7 is connected to a PCM.

Page	 Content Summary

Information	 Various part and serial numbers.

Signals	 Real time monitoring of input and output signals

Diagnostics	 Real time monitoring of all diagnostic trouble code status

Events	 Viewing of PCM event log, statistics and meters

Change Configuration	 Allows the G-II PCM to change part numbers

Table 3-1. PCM window pages.

3.6.1 Information page

The information page displays part and version information about 
the PCM connected to Datalink 7. These items are read-only and 
cannot be edited. 

Figure 3-13. PCM information page.
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3.6.2 Signals page

The Signals page allows you to monitor G-II PCM inputs, outputs 
and variables. Datalink 7 continuously refreshes the data in order 
to present it in real time. 

Figure 3-14. Signals page.
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3.6.2.1 Signal description
The following table describes the signals found on the Signals page.

Signal	 Desciption

Analog Switches	

Standard	 Shows what analog input is active 
Supplemental 
Preheat 
Coolant Pump	

CAN Switches	

Standard	 Shows what CANBus input is active 
Supplemental 
Preheat 
Coolant Pump	

Heater	

Mode	 Shows the mode that is active from the Switches  
State	 Shows what state the heater is in	

Motor Speed	

Target	 The target motor RPM for proper combustion 
	 The actual motor RPM	

Coolant Temp	

Off	 Cycle Off Temperature 
On	 Cycle On temperature  
	 Actual coolant temperature (measured at the  
	 heaters outlet)

Flame Brightness	

Flame ON	 Flame sensor voltage is above the Flame ON set point 
Weak Flame	 Flame sensor voltage is above the Flame OFF and 
	 below the Flame ON set points 
Flame OFF	 Flame sensor voltage is below the Flame OFF set point 
	 Actual flame sensor voltage

Electrical Power	

System voltage	 Input voltage to the heater 
System current	 The total heater current draw 
Motor current	 The motor current draw 
Pump current	 The coolant pump current draw	

PWM Outputs	

Motor	 Shows the Pulse-width modulation (PWM)  
Ignition Power	 in percentage 
Fuel Solenoid 
Pump

Digital Outputs	

Ignition	 Shows what outputs are active 
Accessory 
Ignition Control 
Auxiliary 
Green LED 
Red LED

Table 3-2. Signal description.
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3.6.4 Diagnostics page

The Diagnostics page provides functions that you can use to 
monitor the status of all diagnostic trouble codes. When a 
particular code is active, its corresponding status LED turns red. 
In the example below, trouble Codes 5, 6, 7, 12 & 17 are active.

Figure 3-15. Diagnostics Page.

3.6.4.1 Diagnostic code descriptions

Code Error Description

0 Configuration Error Software problem detected. Contact Proheat for further information.

1 Start Error Indicates that the G-II PCM Flame Sensor did not detect a flame or the flame was too 
weak to be detected during the FULL 30 second ignition period.

2 Flame Out Indicates that a flame was detected but it could not be maintained or after being 
established the flame went out before reaching the cycle off temperature.

3 Coolant Flow Indicates that the coolant temperature in the PROHEAT reached 185°F (85°C) within 
90 seconds in Preheat mode or 60 seconds in Standard and Supplemental modes from 
the beginning of Ignition. There is coolant in the system but its flow rate is too low.

4 Overheat Indicates that the Temperature Sensor detected an inner heat exchanger surface 
temperature of 257°F (125°C). The G-II PCM will detect overheats even if the heater 
is not switched on.

5 Voltage Indicates that the supply voltage to the G-II PCM is outside the operating
range for more then 10 seconds.

Under Voltage Voltage under 10V (12V system) or under 18V (24V Systems).

Over Voltage Voltage over 16V (12V system) or under 32V (24V Systems).

Surge Voltage Voltage over 40V for more than 2 milliseconds (12V & 24V Systems).

Table 3-3. PCM Diagnostic code descriptions.
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Code Error Description

6 Flame Fault Indicates that The PROHEAT reached 185°F (85°C) cycled off and entered Cool 
Down (Purge). After 20 seconds a flame was still detected. OR The PROHEAT was 
switched on and a flame (signal) was detected in Pre-check.

7 Temp Sensor/Coolant Flow The dual mode sensor contains both digital and analog sensing elements and a 
diagnostic code 7 indicates the G-II PCM has detected one of four possible faults 
with the dual mode sensor.

Short Circuit Analog temperature sensor or harness shorted.

Open Circuit Analog temperature sensor or harness open.

No Communication Digital temperature sensor not communicating with the G-II PCM.

Mismatch Coolant flow issue that causes a temperature reading mismatch between the analog 
and digital temperature sensors.

8 Fuel Solenoid Indicates an electrical fault in the Fuel Solenoid Valve coil or in the G-II PCM Fuel
Solenoid Valve circuit.

Short Circuit Solenoid Valve coil or harness shorted.

Open Circuit Solenoid Valve coil or harness open.

10 Ignition Module Indicates an electrical fault in the Ignition Module or in the G-II PCM Ignition Module 
power circuit.

Short Circuit Indicates short circuit fault is detected.

Open Circuit Indicates an open circuit fault is detected.

11 Coolant Pump

Short Circuit Coolant pump output or harness is shorted. (Pump is drawing more than 45 amps.)

Overload Coolant Pump output amperage limit has been reached for more than 200 milliseconds. 
(Pump is drawing more than 10 amps.)

12 Motor

Motor Short Circuit Motor or harness is shorted (motor is drawing more than 45 amps).

Motor Overload Motor output amperage limit has been reached (motor drawing more than 14 amps).

Motor Open Circuit The Motor or harness is open for 2 seconds or more.

Motor Speed Error Motor RPM is under or above target speed for more than 60 seconds.

13 Auxiliary Short Circuit Auxiliary Output , harness or auxiliary device shorted.

14 Accessory Short Circuit Switch Output, harness or accessory device shorted

15 Indicator Short Circuit Indicates a short circuit fault (current draw grater than 1 Amp) in the harness or the 
device being operated by the Indicator Output.

16 System Current

Short Circuit Indicates the instantaneous total system current limit was reached.

Overload Indicates the total system amperage limit has been reached (drawing more than  
25 amps).

17 Motor Speed Sensor Motor RPM signal has not been detected for 5 seconds while normal (less than 12 
Amps) current is flowing through the motor.

18 CANBus Error Indicates the heater was switched on via a CANbus input and then lost the CANbus 
heartbeat message for longer than 5 seconds.

Table 3-3 continued. PCM Diagnostic code descriptions.
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3.6.5 Event logging page

The Event logging page displays the event log and meter information 
recorded by the PCM into its memory. To display the content of the 
event log, press the Read Log button once. While reading the event 
log, the PCM displays the following progress bar.

Once the event log is entirely read, it is displayed in the Logging 
page. The event log contains up to 1024 records and each record 
holds 20 parameters. To navigate the event log and view all records 
and parameters, use the scroll bars.

Figure 3-16. Event logging reading progress bar.

Figure 3-17. Event logging page.
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3.6.5.1 Time and Date display

The time and date associated with each record can be displayed 
using the original event GMT stamp or translated to local time and 
date using your computer time zone settings. To change time and 
date display, use the Time and Date radio buttons. Changing time 
and date display does not affect the event log stored into the PCM.

Figure 3-18. Time and date display.

Event Name	 Event Trigger

Fault	 The first time a fault occurs in a command cycle. See fault section for details.

Power On	 When power is applied to the PCM

Analog standard SW on	 When the analog standard switch is tuned on.

Analog supplemental SW on	 When the analog supplemental mode is turned on.

Analog preheat SW on	 When the analog preheat switch is tuned on.

Analog coolant pump SW on	 When the analog preheat switch is tuned on.

CAN standard SW on	 When the standard switch is tuned on.

CAN supplemental SW on	 When supplemental mode is turned on.

CAN preheat SW on	 When the preheat switch is tuned on. 

CAN coolant pump SW on	 When the analog preheat switch is tuned on.

Heating cycle on	 When the PCM begins a heating cycle (Temp below cycle on set point). 

Heating cycle off	 When the PCM ends a heating cycle (Temp above cycle off set point). Any fault, switch off or  
	 preheat timeout that causes the heater to cycle off, does not count as a heating cycle.

Switch off	 When the PCM is turned off using a switch or button.

Preheat timer off	 When the PCM turns itself off at the expiration of the internal Preheat timer.

Software update	 When the PCM firmware is changed using a computer.

Table 3-4. PCM Events.

Each time an Event listed below happens the G-II PCM will  log or 
create a Event Record with 20 different data fields see Table 3-5 
and Figure 3-18.
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3.6.5.2 Event record parameters

The table below outlines the 20 parameters stored with each record.

No. Event Record Field Description

1 Line Shows what data row you are on shown in descending order.

2 Date Date event was created (also see GMT/Local Setting).

3 Time Time event was created (also see GMT/Local Setting).

4 Event

CODE X: XXXX Diagnostic code number and description.

POWER ON When battery power is applied to the PCM.

Analog standard SW on When the analog standard switch is tuned on.

Analog supplemental SW on When the analog supplemental mode is turned on.

Analog preheat SW on When the analog preheat switch is tuned on.

Analog coolant pump SW on When the analog preheat switch is tuned on.

CAN standard SW on When the standard switch is tuned on.

CAN supplemental SW on When supplemental mode is turned on.

CAN preheat SW on When the preheat switch is tuned on.

CAN coolant pump SW on When the analog preheat switch is tuned on.

Heating cycle on When the PCM begins a heating cycle (Temp below cycle on set point).

Heating cycle off When the PCM ends a heating cycle (Temp above cycle off set point).

Switch off When the PCM is turned off using a switch or button.

Preheat timer off When the PCM shuts itself off at the end of Preheat mode.

Software update When the Firmware was updated.

5 Mode  

Off Heater powered on, but not switched on.

Standard In Standard mode, the coolant pump runs continuously, and the heater is cycled on or 
off according to temperature set points. Will override Supplemental and Preheat modes.

Supplemental Same as Standard mode except the coolant pump does not run when the heater is in 
standby.

Preheat Same as Standard mode except it will automatically switch off after 90 minutes.

Table 3-5. Event record parameters.
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No. Event Record Field Description

6 State  

PowerOn The PCM is connected to battery power (powered-on) and one of the events just 
became active.

Igniter Test Igniter turned on for 5 seconds for diagnostic purposes.

Off PCM has battery power, but all switches off.

Standby PCM waiting for temperature to drop below cycle on set point in standard mode. 
Coolant Pump is running.

Standby Supp PCM waiting for temperature to drop below cycle on set point in supplemental 
mode. Coolant Pump is not running.

PreRun PCM is running coolant pump for 30 seconds to validate temperature is below cycle 
on set point in supplemental mode.

PreCheck PCM verifying hardware before starting.

PreIgnition PCM activating the igniter and ramping up blower motor.

Ignition PCM activating the fuel solenoid and monitoring the flame.

Run Heater is now in Full output.

ReIgnition PCM attempting to ignite the fuel after the flame went out in full output. If the flame 
is out for more than 10 seconds you will get a Code 2 Flame out.

Purge Flame off. Blower running for 3 minutes to cool down the combustion chamber.

Pause Motor off, waiting for 2 seconds before returning to the Off, Hold or Lockout state.

Hold PCM awaiting operator to acknowledge a fault by toggling one of the switches.

Lockout PCM awaiting technician to cycle battery power to acknowledge a fault.

7 Coolant Temp Coolant temperature as measured by the dual mode temp sensor at the Proheat outlet.

8 System [V] Filtered system voltage.

9 System [A] Total System Current.

10 Motor [V] Voltage required to maintain the target motor speed (RPM).

11 Motor [A] Motor Current.

12 Motor [RPM] RPM of the motor (target speed is 3900 +/- 100).

13 Pump [A] Coolant Pump Current.

14 Flame [V] Voltage as seen by the flame eye.

15 Instant [V] unfiltered system input voltage.

16 Heating Cycles A heating cycle counts when the heater (in full output) cycles off by reaching the 
coolant cycle off temperature (185 f is standard). Any fault, switch off or preheat 
timeout that causes the heater to switch off, does not count as a heating cycle.

17 Power Hours Amount of time the PCM has been connected to a battery source.

18 On Hours Amount of time the PCM as been enabled ON in any of the Standard, Preheat or         
Supplemental modes.

19 Flame Hours Amount of time the PCM has been burning fuel (in full output).

20 Lap The PCM can hold 1024 Event records. Once the memory is full, the PCM increases 
the lap number by one and starts overwriting the oldest events.

Table 3-5 continued. Event record parameters.
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3.6.5.3 Log File Sample

As you can see on the highlighted rows is an example of a heater 
log file. The log file is presented with the newest record always at 
the top and the oldest record at the bottom. Reading from left to 
right the event that triggered the log record Line 591 on 18-FEB-
2014 at 19:57:51 was a CAN SUPPLEMENTAL SW ON event, 
the heater was in the OFF Mode and OFF State. At the time of 
the event record the Coolant Temp was 138°F and the voltage 
was 28.0 V. The other data fields show what was recorded at the 
time of the event.

The heater now entered the PreCheck then the PreIgnition then 
finally the Ignition states (these are non recording events) During 
this time a temperature and fault check is done, then the igniter 
is turned on and the blower motor speed is ramped up.

The next record up in the log on Line 590 on 18-FEB-2014 at 
19:57:54 is the HEATING CYCLE ON event, the heater was in 
the Supplemental mode and the Ignition state. At the time of 
the event record the Coolant Temp was 136°F and the voltage 
was 27.4 V The other data fields show what was recorded at the 
time of the event.

The heater now entered the Run state (this is a non recording 
event) until the next recorded event.

The next record up in the log on Line 591 on 18-FEB-2014 at 
20:03:26 is the HEATING CYCLE OFF event, the heater was in 
the Supplemental mode and the Run state. At the time of the 
event record the Coolant Temp was 186°F and the voltage was 
27.8 V The other data fields show what was recorded at the time 
of the event.

Figure 3-19. Example log file screen.
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Figure 3-20. Event log statistics.

3.6.5.4 Event log statistics

The Statistics page shows the historical count of Diagnostic 
Codes and Event.
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3.6.5.5 Counters

The Counters page displays the historical hour meters and  
cycle counts.

The table below describes the different meters displayed in the 
Counters page.

Figure 3-21. Counters.

Name	 Description

Power Hours	 Keeps track of the time heater is connected to battery power.

Operating Hours	 Keeps track of time the heater is enabled ON by one of the switches.

Motor Hours	 Keeps track of time the motor is running.

Flame Hours	 Keeps track of time the heater is in full output.

Total Pump Hours	 Keeps track of time the coolant pump output is switched on.

Vehicle Pump Hours	 Keeps track of time the coolant pump is requested on by the vehicle.

Cycles Count	 Counts successful heating cycles. A heating cycle counts when the heater (in full output) cycles off 
	 by reaching the coolant cycle off temperature. Any fault, switch off or preheat timeout event that 
	 causes the heater to switch off, does not count as a heating cycle.

Start Attempts Count	 Counts heating cycle start attempts.

Good Starts Count	 Counts successful heating cycle starts (heater went into full output).

Table 3-6. Counter descriptions.
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3.7 Change Configuration
The Change Configuration page provides a way to change the PCM 
part number and software configuration if it’s found that the wrong 
PCM part number has been installed for OEM Specific applications.

To use the Change Configuration tool you first must obtain the 
PCM serial number from the information page (see page 3-7) next 
call Proheat Support to receive a configuration change code that 
is valid for the OEM application that the heater is installed in.

Enter the code provided by Proheat Support.

Verify the PCM is changing to the correct configuration number.

Figure 3-22.

Figure 3-23.

Figure 3-24.
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Once configuration has been changed:

1.	Disconnect the diagnostic cable from the computer.

2. Disconnect battery power from the PCM.

3. Wait for 20 seconds.

4. Reconnect battery power to PCM.

5. Wait for 5 seconds. The G-II Status light will flash Green twice.

6. Reconnect the diagnostic cable to the computer and read the 
PCM to verify the configuration number is now correct. 

Figure 3-25.



4-1Section 4: Datalink 7 Menu AND Tool Bars

4.0

4.1

Datalink 7 menu and 
tool bars
The menu bar
The menu bar is composed of 6 drop-down menus: File – View –
Control Menu – Tools, Window and Help. The following paragraphs 
describe all drop-down menus.

Table 4-1. File menu commands.

4.1.1 File menu

The File menu contains the file Open and Save commands.

Command	 Function	 Shortcut

Open…	 Open a complete PCM document from disk.	 CTRL+O 
	 Useful to read saved PCM data while Datalink 7 is not connected to PCM.	

Save	 Save current PCM information to disk for further analysis or archive.	 CTRL+S

Exit	 Exit Datalink 7.	

Figure 4-1. Menu bar.

Figure 4-2. File menu.
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Table 4-3. ECU menu commands.

4.1.3 Control Module menu

The Control Module menu contains the PCM Read and Update 
commands.

Command	 Function

Read	 Read the content of a PCM.

Write	 This function is not used.

Update	 See the Firmware page for more information.

Command	 Function

Toolbar	 Hide or shows the toolbar.

Status Bar	 Hide or shows the status bar.

Table 4-2. View menu commands.

4.1.2 View menu

The View menu contains options to show/hide menu bars.

Figure 4-3. View menu.

Figure 4-4. Control module menu.
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Table 4-4. Tools menu commands.

4.1.4 Tools menu

The Tools menu contains optional settings.

Command	 Function

Users	 This function is not used.

Privilege	 Opens the access privilege window. Note Privilege codes can be obtained form Proheat  
	 Product Support.

Communication Interface	 Opens the communication interface window.

Options ->	 Chooses between imperial and metric units and set the maximum refresh rate.

4.1.5 Windows menu

The Windows menu contains display settings.

Figure 4-5. Tools menu.

Figure 4-6. Windows menu.
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4.1.6 Help menu

The Help menu provides copyright and version information through 
the About... command.  Also, any file found in the Help sub-folder 
will be listed into the Help menu.

Figure 4-7. Help menu.

Command	 Function

About	 Open the copyright and version information window.

Read Me	 Open the readme.txt file.

Table 4-5. Help menu items.
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Table 4-6. Toolbar commands.

Toolbar command	 Corresponding menu command

Open	 Open a saved file.

Import	 This function is not used.

Save	 Save log to a file.

Read	 Read PCM.

Write	 This function is not used.

Update	 Update firmware. See the Firmware page for more information.

Workspace	 Shows the Workspace window.

M-Series PCM	 Shows the M-Series PCM window.

4.2 The toolbar
The toolbar provides shortcuts to the most commonly used 
commands. The table below shows the toolbar commands.

Figure 4-8. The Toolbar.
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